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Prologue
Integrating information and communication technologies (ICTs)
across the education sector is a complicated process. After learning
many lessons from pilot ICTs in education projects and reviewing
local and international experiences, the Namibian Ministry of
Education (MOE) worked with partners across the education sector
to develop the ICT Policy for Education in 2005 and the
corresponding Implementation Plan in 2006.

These ICT Integration for Educators training manuals have been
developed in response to the expectations in this Implementation
Plan. They aim to address the changing roles that educators are
experiencing to better meet the needs of the information society in
which we live.  In order to guide learners to translate information into
knowledge, educators need to be equipped with many skills that
surround the uses and applications of ICTs.  To effectively use ICTs
in education, educators need to consider all areas of their
professional roles.  ICT literacy skills are needed to operate a variety
of applications and equipment.  Also, educators need to be able to
apply these skills in designing lessons, assessments and
evaluations; engaging in continuous professional development; and
using ICTs to support inclusion of all learners in teaching and learning.
In all these areas, educators also need to meet the social, legal and
ethical requirements of using ICTs in education.

ICTs can be used to enhance teaching and learning and will allow
an educator to move from a more traditional educational setting to
a role of facilitation and guidance.  As educators acquire new skills,
classroom practices will also experience change.  These manuals
will help educators prepare for the challenges ahead.  Using ICTs to
enhance teaching and learning fits well with Namibia’s learner-
centred philosophy and its basis in constructivism.  With the learner
participating in the learning process, ICTs can help learners take
control of constructing their understanding, acquiring new skills and
allow them to respond to their own learning styles.  ICTs allow better
communication, collaboration, information access and creative
expression of ideas.

Integrating ICTs in teaching and learning allows the educator to shift
the pedagogical approach towards a balance between teacher-led
and learner-centred collaborative problem solving and critical
thinking.
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Introduction
Welcome to the training manual Operate ICT
applications in an education context.

The purpose of this manual is to give you the knowledge and skills
to use ICT presentation tools, educational software, learning
management systems, word processing and shreadsheet
applications in an education context.

What is in this manual?
This training manual is divided into 5 sections:

Section 1 Use audio/visual hardware and software

Section 2 Create and use ICT presentation applications

Section 3 Identify and access educational software

Section 4 Use learning management systems

Section 5 Use word processing and spreadsheets to support
teaching and learning

Each section starts with an introduction and explains the skills you
will learn. At the end of the section you will have an opportunity to
check your progress by answering some questions.

Skills you will learn:
After you have completed this manual, you will be able to:

• outline the procedures for using audio/visual hardware and
software

• apply the procedures for creating and using ICT presentation
applications

• apply the procedures for identifying and accessing educational
software

• outline procedures for using learning management systems

• apply the procedures for using word processing and
spreadsheets to support teaching and learning.
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How to use this manual
Work through the manual from the beginning. You know that it is
divided into 5 sections. It is a good idea to complete a whole section
in one go if you can. At the beginning of the section you will find a list
of skills you will learn. Read these carefully and return to them when
you have completed your work. It is important that you do not move
on until you have learned all the required skills.

Read each section carefully. You may come across new words which
you do not know. These should be explained in the glossary at the
end of the manual. You will learn many new technical terms as you
progress through this manual and it is important that you learn them
all well

At the end of each section, you will find an opportunity to ‘Check
your progress’. These questions have been carefully designed to
help you to see how well you have understood and learned the topic.
The answers are given at the end of the manual. You can choose to
look at the answers before trying to complete the question yourself,
if you want to. But the only person you will be cheating is yourself.
No-one will take in your manual and mark it for you. You yourself
must judge how well you are doing.

You may also find some practical activities. You will need to collect
the required equipment and carry out these activities. Your instructor
or supervisor will assist you.

At the end of each section, you will find a Summary. Again, you
should read it carefully to review what you have learned. It is a good
idea to check the Skills you will learn at the start of the section
again and make sure you have achieved them all. If not, you may
need to revise the section again.
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What these symbols mean

Symbols are placed in the left hand margin to draw attention to the
type of information at that point.The symbols used in this manual
are:

Read

Demonstrate/discuss - at times your instructor will demonstrate
/ discuss the use of equipment.

Check your progress - these are easy exercises to test your
understanding of the theory you have learnt. Typical correct
answers are provided at the back of the manual.

Practical activity - these activities help you to practise some
of the theory you have learnt.

Learning activity -  these activities help you to relate the
knowledge and skills in the sections to your own work situation.

 Remember/Take Note

Revise

Safety/Caution/Beware
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SECTION

1

Use audio/visual
hardware and software
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Introduction
In this section of the training manual you will learn how to use audio/
visual hardware and software in an education context.

It includes the different types of audio/visual hardware and software,
the advantages of using audio/visual presentations in an education
context and how to plan and deliver a presentation using audio/
visual materials.

Skills you will learn
By the end of this section, you will be able to:

• identify the different types of audio/visual hardware and software
used in an education context

• explain the advantages of using audio/visual presentations in
an education context

• identify and apply the procedures for creating an overhead
projector presentation

• identify and apply the procedures for taking an off-air audio or
video recording

• identify and apply the procedures for taking a live audio or video
recording

• identify and apply the procedures for creating print based
support materials  for use in conjunction with audio visual
materials

• identify and apply the procedures for saving, storing and
retrieving audio/visual materials

• identify and apply the procedures for planning and delivering a
presentation to relevant stakeholder(s) using audio/visual
materials,



11

Operate ICT applications in an education context

ICT Integration for Educators
© Namibia Training Authority - 2006

Types of audio/visual hardware and
software

Figure 1: Passive and active audiovisual teaching and learning tools.

There are many types of audiovisual hardware and software available
for educators to use in the classroom to convey the concepts,
principles and information regarding various subject areas.  Using
audio or visual materials can help you get difficult concepts across
to learners, in a way that text alone often cannot.  Audio and visual
materials can also help reach all learners, whatever their particular
learning needs and styles are.

The various types of audio/visual hardware and software can be
divided into active and passive teaching and learning tools. They
are:

List all the types of audio/visual hardware and software that you
use with your learners currently.  Is there anything that is available
to you that you have not yet tried?

Active Teaching and Learning 
Audio Visual Types: 

Video Player + video tape 

Passive Teaching and Learning 
Audio Visual Types: 

Video Cameras 

Video tape 

Television 

Educational television 
programmes 

Digital Cameras 

Overhead projector + 
transparencies 

Camera Tape player + audiotape 

A computer Recording 
device 

Overhead projector + 
transparencies 

Tape recorder + blank 
audio tape 
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As you will see, some tools can be used both as active and passive
teaching tools.  For example, as an educator you can use
transparencies as part of your presentation when learners will be
passively listening to you, or you can have the learners create
transparencies themselves and present with them.  Both have a
place in teaching and learning.

Once you are familiar with the various types of audio/visuals that
are available to you for teaching and learning it is important to learn
how they work and how you can use them as  presentation tools.

Video player (used with videotapes)
• Video technology, just like television, can effectively show moving

images and, as such, is useful if you want to show procedures in
motion. Operations, such as science experiments in which
sequential movements are critical, can be shown more effectively
by means of this media.

• Video allows learners to observe phenomena that might be
dangerous or are difficult for the learner to perceive, such as
these eclipse of the sun or moon or the eruption of a volcano.

• Learners can also replay the video to help them master a basic
competency or complete an activity.

Television and television programmes
Television brings actual world events into the classroom as the
happens. You can have the learners watch an historical event as it
happens such as the announcement of the results of our
independence election in 1990,  the release of Nelson Mandela from
prison) and these live events are shared with viewers across large
geographical areas.

When learners watch educational programmes via satellite
broadcasting, a large number of learners are reached at a very low
cost per learner.

Audio/Video tape recorder and audio/videotapes
Learners and educators can record their own information for the
classroom on tapes. This is very easy and economical. When the
information becomes outdated, you can make a new recording of
educational material to use in the classroom.

Why do overhead projectors and transparencies figure in both the
active and passive columns? How can you use them in different
ways?
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There is a familiarity about using audiotapes and audiotape players/
recorders, as they have been used in classrooms for many years
and learners are usually familiar with them from use at home.

Learners with special needs and/or learning difficulties can easily
use the audiotape and videotape to improve their reading as they
follow the spoken word on the tape and the text in front of them.

Audio can also provide a stimulating alternative to reading and
listening to the teacher and information can be presented in a very
dramatic way with music.

The best advantage of audio player/recorder and audiotapes is that
it is very portable. It can even be used in a very rural setting with no
electricity, as long as the audio tape recorder can use battery or
solar power.

Overhead projector and transparencies
The overhead projector is known for its versatility and easy use with
transparencies, as you can:

• use it with normal classroom lighting.  Although the best quality
OHT presentation will be with a darkened room (i.e. by closing
curtains), it does not require specialist lighting

• remain in the front of the class facing the learners and making
eye-contact

• point to important facts or items or can highlight these items
with coloured pens or special markings on the transparency

• cover parts of the instructions and reveal it progressively, as a
step-by-step procedure.

Transparencies can be prepared ahead of time and you can reuse
them for future classes.  Learners can also prepare their own
transparencies and use them for presenting their work.
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Advantages of using a presentation
tool

A presentation tool is any device that assists in helping your audience
understand the content for learning. There are mainly four advantages
of using a presentation tool. They are shown in figure 2 below:

Figure 2: Advantages of using presentation tools

 Advantages of using 
presentation tools 

Lesson enhancement Visual stimulation Learner engagement Simulate real 
environments 

Lesson enhancement: Using a presentation tool enhances your
lesson because it adds another dimension to the learning
environment.

Visual Stimulation: Learners are presented with visual stimuli to
help them interpret meaning.

Learner engagement: Learners actively think and respond in a
learning environment according to their own levels of understanding
and providing visual materials can be very motivating for learners.

Simulate Real Environments: Presentation tools can be used to
simulate processes and environments in any subject area. Learners
are visually stimulated and form understanding, when they can
visualise the processes and see the link to real situations.
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Create overhead projector
presentations

Creating transparencies
When creating overhead transparencies (OHTs) , there are different
effects that you could use:

1. writing (computer printing or hand writing)

2. placing a solid object on the overhead transparency (to create a
silhouette)

3. Placing a shallow transparent dish of liquid on the stage (to
create an interesting light effect)

Types of OHT

 Types of OHT Ink-jet transparencies 

Write-on film 

Laser transparencies 

Figure 3: Types of OHT

Write-on film

These transparencies are the old-fashioned ‘acetate’. You can also
write on the other kinds, but you cannot do anything but write or draw
on this kind. In particular, never try to put it through a photocopier or
a laser printer: it will melt. Nowadays, acetates are mainly used when
learners or educators need to prepare OHTs in class.  A write-on
film  has advantages over a flip-chart because it is easier to take
away and type up, but also because only one report is shown at
once. It cannot readily be used for comparisons between reports, or
for overlays on printed OHTs.

Laser transparencies

These transparencies can also be used for photocopying. These
are thicker and heat-resistant, and often come with a backing sheet.
Printing on them generates large amounts of static. Make sure you
tune your printer-driver to give the best quality possible. When highly
magnified, grey-scale may be poor quality.  These transparencies
are used for black/white printing only.
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Ink-jet transparencies

These OHT are still the most expensive but the best for colour. One
side of this transparency has a slightly “gritty” covering: that is the
side which will take the ink, so make sure it faces the right way up.
They can take a long time (15 mins +) to dry, and a fast printer may
deposit a new sheet on top of one, which is still tacky, often with
unfortunate results. Take each transparancy out of the printer as soon
as it is printed and put it somewhere safe to dry.

Do not try to put this kind of transparency through a photocopier or
laser printer.

Note that using a template from a computer package, which gives
you a tinted background, will greatly increase the printing time, and
usage of ink.

Again, explore the printer-driver options for best quality: most printers
allow you to specify that you are using transparencies.

Most ink-jet printers allow you to print the content reversed left to
right. If you use that option, the image will be on the back of the
transparency when projected properly. That means you can annotate
it with water-based pens on the front as you are using it, and then
wipe the notes off and re-use it.

Pen and Print

Pens for write-on film come in two kinds: permanent and water-
based. Water-based marks can be washed off laser transparencies
for re-use, but not off ink-jet transparencies.

Make sure that your handwriting is clear and easily readable and
that images or graphics are of good quality.  If you print onto a
transparency, make sure your original is well-laid out and all the black
and white images show a good contrast.
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General Tips

• Leave a margin on all four sides
of the text.

• Use large letters/characters. If
you use word processing
software, use bold type, 28 point
or larger. Please note that the
projected image is distorted in
such a way that the upper part of each page is considerably
larger than the lower part. To balance the image, make the
characters on the bottom of the sheet larger and farther apart
than those at the top.

• Use no more than 12 lines per sheet: leave space between
lines.

• Limit each transparency to one topic. Complicated problems
may, however, be simplified in presentation by the use of
overlays, which consist of several acetate sheets. A complex
image can be built up from simple components added to the
picture, one at a time, by turning the pages. This type of
presentation can be very effective but needs careful preparation.

Use the guidelines above and create a transparency for a class
you will teach in the near future.  Use only black, blue, green or red
overhead projector pens. Do not use pink, yellow, orange or any
pastel colours.

Designing OHTs (with PowerPoint™) presentations

1. Think of your OHTs as a linear sequence, rather than as “one-
offs”.  Do not try to cram too much on each one.

2. Keep simple.

3. If at all possible, use a presentation package such as Microsoft
PowerPoint, or OpenOffice Presentations to prepare them.

If you use a word-processor:

Use landscape rather than portrait format, with wide left and right
margins (12 pica, 5cm, 2 inch). This stops the line getting too long,
and also ensures that the border of the OHP stage do not cut off the
edges of your OHT. Landscape rather than portrait makes it less
likely that you will try to cram too much in.
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THIS IS WRITTEN AL IN
UPPER CASE OR CAPITALS IT

IS DELIBERATELY IN A
SMALL FONT TO SHOW AN
EFFECT SIMILAR TO THAT

OF VIEWING A SCREEN
FROM A DISTANCE.

Photographs and other figurative pictures are ‘bitmaps’, made up
of pixel dots, which get chunkier if you enlarge them, or run into
each other if you reduce them: unfortunately, all but the most
sophisticated Web graphics at the time of writing are bitmaps.

Use a large font size of (28pt if possible, but a minimum of 18pt):
this is recommended for legibility. Software packages may
encourage large sizes by default.

4. Use both UPPER and lower
case for your text: this shows the
shape of the word more clearly
and greatly enhances legibility.

5. One topic and three or four
points per OHT is generally
enough—certainly no more than
six.

6. Use bullet points and paragraph spacing to distinguish the points:
all packages encourage you to use a hierarchy of bullet points
to show the relative importance of the topics

7. You can also use bold face and larger sizes or both (and colour)
to emphasise key words or phrases. Do not use underlining - it
interferes with the shape of the word.

8. Be selective about what you emphasise - too many competing
emphases become confusing. Putting everything in bold does
not help legibility.

9. Use graphics if possible, such as, diagrams, charts, and the
occasional scanned picture. All software packages have simple
but adequate drawing tools, so you can create your own simple
graphics easily.

10. If you use pictures, use simple outlined drawings where possible.
This makes changing the size easier and they will remain
accurate.

11. Use mind-mapping if possible to give an overview of your
presentation. You can keep returning to the mind-map OHT to
help learners keep track of what has been covered. You can
also give it to them as a handout to help them to structure their
own notes.

12. Do not photocopy blocks of text from a book onto an OHT. If you
need direct quotations, scan them and use an Optical Character
Recognition (OCR) program to convert them to text so you can
format them properly.
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Operate Projector
The OHP is a simple machine: it has a lamp in the base (although
there are portable versions which project a lamp downwards from
the lens housing onto a reflective stage), usually cooled by a fan.
The lamp may have high and low settings, and a “fringing” control to
position it centrally. Some machines have a device to change bulbs
if one blows. There will be a cut-out
system which switches off the
power automatically if you
open the base.

The light is distributed to
illuminate the stage evenly,
and then focused by a lens
and mirror arrangement
(often enclosed), onto the
screen.

The focus knob moves
the lens assembly up and
down a column.

The OHP needs to be square to the screen:
otherwise the image will be distorted.

Note, too, that the reflectivity of screens may fall off
rapidly as the viewer moves to the side. Providing
a good view means paying attention to seating
arrangements. (Try and arrange learners at the
beginning of a class as having people move to be
able to see in the middle of the session is
unnecessarily disrupting)
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To operate an OHP, you need to:
1. Place your transparency on the ‘stage’

A popular technique for using OHTs
is that of the “reveal”. You start with
the OHT concealed by a piece of
paper, which you withdraw paragraph
or point by point, as you talk about them.
It does have the advantage of keeping
previous points on screen as you proceed...

2. Another option is to build up a sequence of slides, in which the
earlier points have been de-emphasised by making them
smaller, or greying them out, so that they do not compete with
the current point.

3. Switch the machine on.

4. Adjust the mirror if necessary (see on previous page).

5. Adjust the focus control in necessary.

6. For longer lamp life:

• Turn off machine and let cool - if necessary, open
compartment.

• Installation: Hold lamp with clean cloth. Wipe off fingerprints
before turning on the projector.

• Do not use a scratched lamp.

• Do not twist lamp. Pull the old lamp from socket, and push in
new lamp.

• Socket condition affects lamp life: replace the socket if it is
deteriorated.

• If available, use low or dim setting to conserve lamp life.

When to use the OHP
Overhead projectors are very useful in educational situations
because they are reliable, familiar, easy to operate, they do not
require a completely darkened room and you can keep good eye
contact with the learners.

The OHP is most suitable in situations where the presentation is
informal. This includes most teaching situations and some
conference presentations.

One advantage the OHP has over all other presentation media, is
that it offers genuine random access - quickly, accurately and
without technological assistance. It is often the preferred medium
for teachers who are familiar with their visual materials, prepare
and label them carefully and want to respond on-the-spot to questions
which arise during lectures.
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Inappropriate uses of the OHP

When you need to project an image in full colour the OHP can be
used, but it is expensive to produce full colour photographic
transparencies. It is better to use the 35mm slide projector which is
designed to project photographic images.

An OHP should not be used for projecting rough hand-written
notes or photocopied excerpts from text books, papers and
journals. This is poor practice because it cannot be read at the same
time teacher or presenter is speaking at the same time.

It is not possible to read a quantity of projected words, listen to
what the lecturer is saying, make sense of both, create a summary
and takes notes - simultaneously

Save, Store and Retrieve Transparencies
Save: As with all materials, lesson plans and other technological
aids, you need to save your work and back it up, where possible.

Store: With everything you save, you should name it or label it
properly and store in a safe place for future use.  Transparencies
should be separated from each other by a piece of paper, so that
they do not stick together.

Always back up any work or files that you have created on the
computer.  There is nothing worse than losing all your hard work
when a device becomes corrupt or a computer crashes.

Make sure you make a note of where you save and store your work,
so you can easily retrieve it at a later date.
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Off-air video and sound recording
You may want to record audio and visual materials for your learners
from a television or radio programme outside of its transmission
time. Or you might want to record excerpts from an existing video,
without moving from one scene to another in front of the learners.
This will enable you to edit your clip for your teaching and learning
activity.  In these cases, you will need to make ‘off-air sound and
video recordings’.

Identify source material
Video: Many schools subscribe to DSTV, a valuable resource. When
reviewing the monthly television guide for possible programmes on
specific subject topics, you can schedule your timeslot for recording
the educational video.  Programmes are often scheduled to show
more than once (at various time slots) during the month.

The public library is another source to get educational videos.
Nowadays many of the video shops keep a tiny section on
educational related videos. On the Internet you can search and order
videos for your school.

Audio: The Namibian Broadcasting Cooperation (NBC) and other
radio stations have many interesting and relevant programmes being
broadcast over the radio. Check the radio broadcasting schedules
in the Newspapers or on the internet or best when listening to the
radio stations.

Identify recording equipment
Video: To make an off-air educational video you will need two video
recorders/players and a television.  The video recorder input and
output cables must be correctly connected.

If you make your own educational video, you can play it through the
video recorder to the television.

Audio: You will need a machine that has two audio tape decks (for
example, a popular choice for classroom, small hall, outdoor use is
the music centre. These provide portability and sufficient volume for
most situations). The high speed tape dubbing facility is what you
will need to record from an ‘off-air’ recording.
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Identify blank audio/video tapes
It is always best to label your audio/video tape recording clearly.
The best way to tell is generally to replay the audio/video tape.

Record an audio/visual clip
Video:

• You will need to play the video in one machine and place your
blank video cassette in the other machine.

• Once you have rewound both video cassettes, you will need to
press ‘play’ on the machine containing the content video cassette
while at the same time pressing ‘record’ (or ‘play’ and ‘record’)
on the machine containing the blank video cassette.

Audio:

• You will need to put your content audio cassette in one tape deck
and place your blank audio cassette in the other tape deck.

• Or you will need to tune the radio and place the blank audio
cassette in the tape deck

• Rewind the audio cassette(s)

• Press ‘play’ on the one machine containing the content audio
cassette while at the same time pressing ‘play’ and ‘record’ on
the machine with the blank audio cassette

• If recording from the radio, you will just need to press record on
the tape deck when the radio programme is about to start.

Save, store, backup, retrieve clip
Save:

As with all materials, lesson plans and other  technological aids,
you need to save your work and back it up, where possible.

With everything you save, you should name it or label it properly and
store in a safe place for future use.
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Store:

• Always keep your valuable audiotapes in the plastic containers
and away from heat, moisture and magnetic fields.

• Always take up any ‘slack’ in an audiotape prior to putting it into
a cassette recorder. This will minimize the risk of the tape getting
tangled.

• Always clean the Erase and Recording/Play Heads on a
regular basis. ‘Dirt’ can easily build up on these heads and will
often result in very poor recording and playback sound.

• Use a cotton bud and a little menthylated spirits to make a
thorough job of cleaning your tape heads.

• Other items that will also benefit from regular cleaning are the
Pinch Roller and Capstan which can be seen in the bottom right
of this picture. If these items are dirty often playback speed will
suffer or your tape may be damaged.

You will need to make a note of where you save or store your
materials so you can easily find them again. It is a good idea to
create a small database such as on a spreadsheet, listing what
you have available and where you have stored it.
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Live video and sound recording
You may want to record audio-visual materials for your learners at
the time that it is being transmitted or the scene is taking place.  You
will then need to make a live video recording.

Identify source material:

Video:
Once you have decided on the topic that you want to record (based
on the curriculum and theme), you need to start planning the scenes
and background shots. If possible, use an environment with which
the learners can identify.

Plan the series of shots.  Think about:

• the opening shot

• how to use wide angle shot

• the role close ups will play

• how you will move the camera (pan/tilt),

• how long will you shoot for.

Run these points through your mind when you are planning and try to
visualise the recording.

Audio:
You will need to plan and prepare before making a live audio
recording. If you are recording a real-life situation, you will need to
consider what background noises could be distracting.  If you are
going to record learners presenting a play or a speech, they will
need time to prepare.  If you are recording from the radio, you will
need to make sure what time your programme is on.

• Bring an extra battery and tape and the power cords if possible

• Check to be sure you are taping. Normally a red light will go on
to indicate to you that the tape recorder is recording.

• Experiment and be creative.

In table 1 on the next page are a few sound effects you can use
when you do an audio recording. These sound effects can make the
audio presentation interesting.
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Table 1: Sound effects for audio recording for educational use.

The Wonderful World of Sound Effects

Boiling water - blow gently Into a glass of water with a straw.

Something falling into water - fill a bucket with water and immerse a large tin can
into the bucket until it is full. Keep tin under water and
turn upside down so that bottom is facing upward.
Pull the inverted tin sharply out of water.

Crash - place bottle tops and small tins in an old roasting dish.
Firmly hold dish and shake vigorously.

Telephone voice - hold tumbler at one end of mouth. Talk across the end
and partially into it.

Fire - screw up pieces of cellophane near the microphone.
Crushing some polystyrene produces the effect of a
burning building.

Waves and surf - tilt some metal balls in a cardboard box, allowing the
shot to roll around.

Walking in mud - soak crumpled newspaper in a bucket. Push and pull
hands in and out of wet newspaper.

Breaking door - crush a (small fruitbasket) punnet near the microphone.

Horses’ hoots - patting thighs or chest with a galloping rhythm.

Car brakes - inflate a rubber balloon and pull fingers slowly but firmly
over the surface.

Motor - pour dried beans or peas on board or cake tin. Use a
funnel to assure constant rhythm

Man running - pounding chest with clenched fists. if you can make
use of an “open-reel” recorder with different speed
settings, many more possibilities open up (e.g.:
gunshots, “Chipmunk” - style renditions).

Rain - rice dropped on board or tin.

Check time of transmission
If you are making a live recording from television or radio, make
100% sure of the time it will be broadcast and prepare the video
machine/tape recorder for the time. It is always best to have the
machine start a few minutes before the actual programme is aired
and allow for a few minutes after, as live broadcasting can be
unpredictable.

Identify recording equipment
Video: Any live recording requires a television set, which is switched
on at the time of the transmission and a videomachine connected to
the television. Always test the video to make sure it has not been
used before and that you might be taping over existing material.
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Also test the video machine beforehand, by taping something short
on television and then replaying it. Once you are sure that it works,
you can always tape over the test material.

You will need a video camera and a blank cassette, or a digital video
camera with a memory card or disc inserted if you are going to
record a live video yourself.

Audio: In order to make an audio recording you need a good
microphone and a radio-cassette player/recorder.  The average
cassette recorder has a fairly low output in terms of volume.
Unfortunately, when used at a level for
comfortable classroom listening,
distortion occurs and once again clear
listening becomes difficult. This difficulty
can be overcome in either of two ways.

1. Use a better quality speaker. Plug
this into the monitor socket of the
tape recorder.

2. Use a ‘Booster” amplifier, a device which takes the tape signal
and boosts it to a very comfortable level, ideal for classroom
use. Because of the amplification available, little distortion is
produced.

Identify blank audio/video tape
The simplest way to find out whether a tape is used or new is to play
it back in the tape recorder or video machine. Once you have
recorded onto a new audio or video tape, use the labels provided
and write the specific activity on the label, as well as the date when
it was recorded.

Record audio and/or visual clip
Below are a few helpful hints when making video camera recordings:

• Bring an extra battery and tape

• Turn camera off when not in use to save valuable battery energy

• Check to make sure you are taping. Often a red light will go on
to indicate to you that the video recorder is recording.

• Do not cut off a person at any ‘natural’ body division (i.e. hands,
feet, knees, eyes, nose, chin, mouth, neck)

• Watch where your subject is heading. For example: notice if he/
she is not centred in the video, and provide extra space in the
direction where she is looking

• Press record a few seconds before the ‘action’ starts and a few
seconds after the action finishes
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• Do not use too much zooming. This slows down the action.

• Panning is great when done properly. You might want to use a
tripod.

• Experiment and be creative: provide a variety of shots

• A good sound track can make a video a very interesting learning
resource.

It is possible to edit your videos using only a camcorder and
videocassette recorder (VCR). This will allow you to copy the scenes
that you want to another tape. You will also be able to rearrange the
order of your shots in order to tell your story.

Connect the video and audio outputs of your camcorder to the audio
and video inputs of your video cassette recorder. You will also need
to connect a television monitor to the output of your VCR and select
the auxiliary input on your VCR to view the signal from the camcorder.

Save, store, backup, retrieve clip
Revise: go back to the section on off-air recording and revise the
tips for saving, storing, backing-up and retrieving.

Without looking at your notes, write as many tips as you can under
the following headings:

Save:

Store:

Backup:

Retrieve:

Go back and check your notes against the materials. How much
did you remember?
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Create print based support materials
You should always try and make a worksheet or a handout to
accompany an educational video or audio clip.  This should be
created using ICTs for clarity and readability.  A well-designed
handout helps focus the learners attention and helps them sequence
the main ideas.  It can also help them revise the content of your
lessons at a later date.

Review content of recording
It is important to review your video tape so that you can identify
important information and design questions and/or activities
surrounding the key points and main issues.

The best way to ensure that you only ask questions or create
activities around relevant points is to ask another colleague to listen
or watch your recording with you and take notes. Then only ask
questions or make activities around the points that both of you note
down.  If you listen or watch a clip too many times before creating
your worksheet, you may hear many details that the learners will
miss if they only listen of watch once.

Create worksheets for teaching and learning
1. Make sure you have designed the worksheet in such a way that

it is clear whether the learners are to take notes and then answer
questions, or whether they should answer questions on the
handout.  If they are to answer on the handout, make sure you
have left enough space for them to write.

2. Check that the sequencing of your activities matches the
sequence of the audio/visual clip

3. Do not try and cram too much onto a worksheet.  Learners will
have to listen, watch and write simultaneously.
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Save, store and retrieve audio/visual
materials

Save
As mentioned in previous sections, all audio/visual materials need
to be saved, stored and retrieved for future use.

With everything you save, you should name it according to a system
you will understand and remember and store in a safe place for
future use.

If you have a system for naming and organising your files yet, you
should think about starting one.

List the different ways you could save and organise your materials

You could think of saving your materials by:

• year

• class

• subject

• activity type

Here are some more detailed tips to help you preserve the life span
of your materials.

Store
Unfortunately video and audio tapes have a relatively short life
expectancy, which makes them more difficult to preserve as
educational material. Treating them carefully will maximise their life
span.

• Store audio/videotapes upright (i.e. standing up on end like
books) with all the tape wound on one reel; leaving them flat or
partially wound can result in warping of the protective case or
distortion of the tape.

• Keep audio/videotapes at least 7 cm away from magnetic
sources and do not store them next to stereo speakers or under
television sets.

• Avoid extremes or fluctuations of heat and humidity. Keep them
away from heat vents or strong sunlight
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Location
Video tapes require special storage facilities in order to maintain
and prolong their useful life.  These materials require appropriate
temperature and humidity storage conditions.

Audio tapes should be kept in cool places and out of direct sunlight
which can damage the physical tape case and the magnetic strip.  It
is a good idea never to leave audio/visual/tapes in your vehicle.

Causes of Damage
Videotapes may not play properly when dirty because they clog VCR
heads. The base can become damaged by uneven winding from
recording or playback; this results in tracking problems when the
tape is played.

Sound recordings can suffer chemical, mechanical or physical
damage.

The most common causes of damage are:

• improper handling

• extremes or fluctuations in heat and humidity.

Dust and debris that get trapped between the layers of wound tape
or accumulate in the equipment can also result in damage, i.e.
scratching and equipment contamination. Magnetic fields (from
televisions, speakers, magnets, vacuum cleaners, etc.) are a
problem only if they are strong and close to the tape.

Retrieve
Once you have saved and stored your materials, make sure you
handle them properly when you retrieve them:

Handling:
• Pick up audio/videotapes by their plastic cases; do not touch

the tape or allow dust to come into contact with it. Food, drink,
and cigarette smoke can contaminate tapes and must be kept
away.

• When playing ( ) an audio/videotape, avoid placing it on
“Pause” (II) for long periods as this places stress on the tape.
Likewise, do not shuffle between “Fast Forward” ( ) and
“Reverse”( ) without first stopping ( ) the tape. After playing,
ensure that the tape is fully wound on one reel before removing
it for storage.
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See illustration of simple database to locate stored materials below:

English class 2006: listening comprehensions

           Topic           Resource type Stored Date used

Non-verbal video cartoon library 02/02/06
communication

Reports video business library 03/10/06
reporting

Letter writing video weather report file: office 23/03/06

Presentations audio clip speech:radio file: office 16/04/06

Simple database/list worksheets
After naming your audiotapes and videotapes make a short list using
a word processor or a spreadsheet. It is important that the list is
easy to use so that you can retrieve the audio/visual material without
any difficulty.
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Plan and deliver a presentation
using audio/visual materials

Planning
Beginning to plan your lesson presentation starts with extracting the
topic from the curriculum. Once you are clear on the objectives that
are required to meet the standards of this topic, you can go ahead
with planning the unit.

When you decide on the audio/visual medium to use It is always
important to ask how the audio/visual materials will enhance
the learners’ learning process.

Each of the media listed in Table 2 below has specific characteristics
that can be used in the classroom to help you plan.

Table 2: Characteristics of various types of audio/visual hardware and software

Types of Audio/Visual Media Visual Colour Sound Motion

Overhead Transparencies

Overhead projectors /Slides
(connected to computer)

Video player and videos

Television (Live)

Audio tapes

Apply presentation principles

Using your voice

Projection: Speak louder than usual: throw your voice to
the back of the classroom

Articulation: Do not swallow words. Beware of verbals “tics”
like “Er’ “Uhm, “OK”, “You Know”, “Now”, etc.

Modulations: Vary tone and pitch: be dramatic, confidential and/
or triumphant.

Pronunciation: Watch your accent, check difficult words, beware
of mispronouncing words

Enunciation: Over emphasise, Accentuate syllables

Repetition: Repeat key phrase with different vocal emphasis

Speed: Use delivery speed to manipulate the
audience,Fast delivery to excite and stimulate
and;Slow delivery to emphasise, awe, dramatise
and control.
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Figure 4: Mannerism to use when presenting and responding to questions.

Mannerisms
You might not be aware of the habits that distract and irritate your
learners. The only way to discover these is to ask someone to (gently)
criticise your presentation delivery or to watch it on video.

Below are some hints:

• Do not be tempted by manual props (pens, pointers, etc.)

• Do not keep loose change in your pocket.

• Be aware of your verbal “tics” and work on eliminating them (i.e.
“Er’ “Uhm, “OK”, “You Know”, “Now”, etc.)

• Avoid closed or tensed body positions.

• Do not worry about pacing or leaning.

• Check your hair/trousers/tie/dress before standing up!

Tips for using a video in a presentation

Before Presentations:
1. Be sure the videotape is rewound and at the starting point. Do

this right after you show the film.

2. Check to make sure the playback machine and the monitor are
playing properly. Check this before the session so you may
replace the machine if it is not working properly.

3. Check audio level and contrast.

4. Lights should be dimmed but not turned off.

During Presentation:
1. Explain what the purpose of the tape is before playing it.

2. Show interest in the tape and watch it enthusiastically.

3. Summarise the main points after you have shown the tape.
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Tips for using an audio clip in a
presentation

Before Presentations:
1. Be sure the tape is rewound and at its starting point.

2. Adjust the volume so all learners can hear.

3. Use a high quality recorder to prevent distortion.

4. If the recorder is portable, position it at the table level of the
learners.

5. Explain the purpose of the tape and identify the speaker before
playing.

6. Always carry a backup tape!

During Presentation:
1. Explain what the purpose of the tape is before playing it.

2. Show interest in the tape and listen to it enthusiastically.

3. Summarise the main points after you have listened to the tape.

Evaluate use of audio/visual tool
At the end of each lesson presentation, it is always useful for both
you and the learners to evaluate the lesson. There are a few questions
regarding the audio/visual material that are important to review:

- did the audio/visual resources enhance the instructional use for
the learner’s particular grade level and content area?

- did your learning activities enhance the diverse learners? Did it
assist in involving your learners in learning to use audio/visual
resources to find information and evaluate the authority,
accuracy, currency, and relevance?

- how effective were the activities when you used audio/visual
resources to access information as compared to, or combined
with traditional methods in producing intended learner outcomes
for all learners?

Modify materials/delivery strategy
Once you have evaluated the effectiveness of the audio/visual
material, it is important to modify the material or modify your delivery
strategy to try and improve on areas that did not work as well as you
wanted.
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CHECK YOUR PROGRESS 1

USE AUDIO/VISUAL HARDWARE AND SOFTWARE

1. The following are types of audio/visual hardware and software that you
can use in the classroom. Tick the appropriate boxes:

� Mix and put a box for each

� Video Cameras

� Transparencies

� Overhead projector

� Computer recording device

� Digital Cameras

� Television

� Cell phone

� Web blog

� Telephone

� Fax

� Memory stick

� Diskette

2. The following are reasons for using audio/visual presentations in an
education context:  Tick True or False:

Learner enhancement � True � False

Visual Stimulation � True � False

Educator interest � True � False

Learner engagement � True � False

Kinaesthetic stimulation � True � False

Simulate Real Environments � True � False

Lesson enhancement � True � False
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CHECK YOUR PROGRESS 1

3. List 3 creative ways to use transparencies for use in an OHP presentation

_____________________________________________________

_____________________________________________________

_____________________________________________________

4. List 3 tips for creating an OHP transparencies:

_____________________________________________________

_____________________________________________________

_____________________________________________________

5. a)  Put the following steps for operating the projector in the correct order:

� Adjust the mirror if necessary

� Place your transparency on the ‘stage’

� Switch the machine on.

� Adjust the focus control in necessary.

b)  The following are tips for making the lamp last longer – true of false:

a. always keep the machine turned on � True � False

b. Installation: Hold lamp with clean cloth. Wipe off fingerprints before
turning on the projector. � True � False

c. Do not use a new lamp. � True � False

d. Do not twist lamp. Pull old lamp from socket, and push in new lamp.

�   True � False

e. Socket condition affects lamp life: replace socket if deteriorated.

�  True � False

f. Use the brightest settings when possible  � True � False
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CHECK YOUR PROGRESS 1

6. The following instructions are the procedures for taking video and sound
recordings. Place them in the table in the correct columns and in the
correct order.

NB! Take note - some will be the same for each column

Save, Store, back-up your recording

Plan your scenes and shots

Identify source material

Check the transmission time of your programmes

Find a blank tape

Identify your recording equipment

Record your audio or visual clip

Off –air video/sound recording Live video/sound recording

7. What do you need to do before creating print materials for an audio/
visual clip?

_____________________________________________________

_____________________________________________________

_____________________________________________________

_____________________________________________________

_____________________________________________________

_____________________________________________________
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CHECK YOUR PROGRESS 1

8. Match the tips in the left hand column to the procedures listed on the
right:

Save

Store

Retrieve

Put your materials into appropriate folders

Make a database for your materials

Put your materials in a dust-free environment

Save your files in folders by year (eg, 2005,
2006)

Pick up videotapes by their cases

Keep videos upright

Rewind your tapes so all the tape is on one reel

Keep tapes in cool dry places

Wash your hands before handling tapes

List where you store your materials

Organise your files according to activity type

Keep tapes away from magnetic sources

Save your documents according to the class you
use them with

9. Create a diagram that shows the procedure for planning and delivering a
presentation using audio/visual materials:
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USE AUDIO/VISUAL HARDWARE AND SOFTWARE

1. Create an interview situation for your learners. Help them develop
questions on a relevant topic and have them record the responses from
their interviewees.

2. Have your learners present a speech or recital and record it to evaluate
it with them.  Some ideas are given below:

(a) Brief discussion on Namibia, the educational regions, the Ministry
of Education - number of children, teachers, special features, a
national hero,  etc.

(b) Singing the national anthem

(c) Brief dramatisation of the work of an early explorer - Cook,
Tasman, ‘Coming of the Bushman’.

(d) Dramatised or spoken national legend

(e) Short recital by School Orchestra or Choir

(f) Present basic facts about an indigenous animal

(g) On the spot description of some school sporting event

3. Make an audio recording with your learners and have them create some
sound effects suggested in the section ‘Live video/sound recording’.

PRACTICAL  ACTIVITY 1
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Summary
Well done! You have completed Section 1 on Use audio/visual
hardware and software.

You should now be confident that you can identify different types of
audio/visual hardware and software and explain the advantages of
using them in an education context.  You should also be able to
identify and explain the procedures for creating an OHP presentation,
taking live and off-air audio and visual recordings.

In addition, you should feel able to apply the procedures for creating
print based materials and handouts to accompany your audio/visual
clips and be able to apply the procedure to save, back-up, store
and retrieve all your materials.  You should also now feel confident
to plan and deliver a presentation using audio/visual materials.

If you feel confident that you have achieved the above, you can move
on to the next session where you will learn how to create and use
ICT presentation applications.

If you are unsure of any part, go back and revise or ask your instructor
for assistance.
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Section

2

Create and use ICT
presentation
applications
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Introduction
In this section of the manual you will learn how to create and use ICT
presentation applications.

You will learn about the reasons for using ICT presentation
applications and how to apply the procedures for planning and
delivering an ICT presentation in an education context.

Skills you will learn
By the end of  this section, you will be able to:

• define the term ICT presentation application

• explain the reasons for using ICT presentation applications in
teaching and learning contexts

• describe and apply the procedure for creating an ICT
presentation

• describe and apply the procedure for delivering an ICT
presentation to relevant stakeholder(s).
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Understanding ICT presentation
applications

An ICT presentation application is a complete presentation graphics
program that allows you to produce professional-looking
presentations. A presentation is a page that can be seen on the
computer screen as normal and, with the use of a projector, the page
can be seen on the wall or on an external screen.

Using a presentation application is like delivering a slide show. One
page after the other is projected. Examples of commonly used ICT
presentation applications are Open Office Impress, Microsoft
PowerPoint and WordPerfect Presentations.

Open Office Presentations and PowerPoint are presentation
packages suitable for creating electronic presentations, plus
overhead transparencies, handouts, outlines and speaker notes.

The main purpose of ICT presentation applications is to:

• show the focus of a speaker’s message in key points; and

• enhance the meaning of a presentation with multimedia, i.e. text,
graphics, animations and sound.
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Reasons for using ICT presentation
applications

There are four main reasons for using ICT presentations application.
These are:

Figure 5: Four main reasons for using an ICT presentations application

 

Demonstrations
You can instruct the presentation application to create pre-designed
presentations and then modify the presentation to fulfill your
requirements. It is ideal to demonstrate principles or animations.

Modelling
You can easily model any process with a simple animation. It might
take some time for you to prepare, but it would be worth it when you
see how easily your learners grasp the concept, and you can re-use
it for later classes.

Learner engagement
You can engage the learner by using a different medium to present
information.  This will help with retention and increase interest and
motivation. You can build answer and feedback slides into the lesson
presentation.

Visualisation
In the classroom you can make your
presentation more impressive by
adding tables, graphs, pictures, videos
and sound. Presentation graphics help
people see what they hear. People tend
to remember 10% of what they read,
20% of what they hear, 30% of what they
see and 70% of what they see and hear.
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When used properly the use of presentation applications can:

• increase understanding and reduce confusion

• increase audience involvement

• reinforce key points

• make dull statistics come alive

• freshen an old message and

• give the presenter a feeling of confidence and control.

In the classroom, presentation applications can be used by:

• learners presenting their own ideas, as they learn about the topic

• educators achieving their goal of explaining a concept or
introducing a small section of  content and

• educators creating clear illustrations used as transparencies.
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Create an ICT presentation
There are different types of presentation applications, but not enough
room to cover all of them.  The two main presentation applications
used in Namibia by educators are Open Office and Microsoft Power
Point.  Instructions for creating a presentation will be given for both
of these applications.

PowerPoint - Creating a Multiple slide
presentation 

1. From the Start button select PowerPoint or select                          the
icon from the desktop. 

2. A pop-up screen will appear.  (The actual screens will depend
on the version of MS Office your school is using, but they are
more or less the same.)

3. Select Design Template.

PowerPoint provides ready-made layout options for you to use.
Select the first Title Slide for the title of the presentation.  The other
layouts can be selected when necessary.
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4. In the box labelled Click to add title type in the title of the
presentation.

5. Add a subtitle if necessary, by clicking in the block labelled Click
to add subtitle.

Insert a new slide 
6. From the menu bar Insert, insert a New Slide. Select a suitable

layout.
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7. Save the work regularly, using a filename that describes the
presentation.

PowerPoint - Viewing the presentation on screen
in different modes
There are five ways of viewing the presentation on screen:

1. Slide Show view

2. Slide view

3. Normal view

4. Outline view

5. Slide Sorter view

1. In Slide Show view, you can see your slides on a full computer
screen, as they will appear in your presentation.  To do this:

• Go to the View menu,  click on Slide Show.

2. In the Slide View, you can see your text on your slide as well as
the slide itself. You can add graphics, movies, and sounds, create
hyperlinks, and add animations to individual slides.
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3. Normal View contains three panes: the outline pane, the slide
pane, and the notes pane. These panes let you work on all
aspects of your presentation in one place. You can adjust the
size of the different panes by dragging the pane borders.  The
notes pane lets you add your speaker notes or information you
want to share with the audience.

4. In Outline View, you can use the outline pane to organise and
develop the content of your presentation. You can type all of the
text of your presentation and rearrange bullet points, paragraphs,
and slides.

5. In Slide Sorter View, you see all the slides in your presentation
on screen at the same time, displayed in miniature. This makes
it easy to add, delete, and move slides, add timings, and select
animated transitions for moving from slide to slide. You can also
preview animations on multiple slides by selecting the slides
you want to preview and then clicking “Animation Preview” on
the Slide Show menu.
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PowerPoint - Move through slides in
presentation
You can add movement to a PowerPoint presentation with transitions.
You can also add a special effect to introduce a slide. For example,
you can fade in from black or dissolve from one slide to another. You
can choose the transitions you want, and you can vary the speed of
each.  Do not add a transition to the first slide as it should be visible
before the presentation begins, to focus the audience on the
forthcoming presentation.

To insert a transition to a slide

1. On the menu bar click View, then Click on Slide Sorter.

2. Select the slide or slides you want to add a transition to. To select
more than one slide, press the Ctrl button on the keyboard while
clicking on the slides with the mouse.

In the illustrated example the transition is between Slide 1 and Slide
2 in the Slide Sorter View.  On the small down arrow , open the
box to select the transition you want.  Repeat the process for each
slide you want to add a transition to.
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Or  

In the menu bar

1. Click on Slide Show then

2. Click on Slide Transition.

3. In the Effect box, click the transition you want, and then select
any other options you want.

To apply the transition to the selected slide:

4. Click Apply.

To apply the transition to all the slides:

5. Click Apply to All.

To view the transitions:

6. Click Slide Show, then

7. Click on View Show
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PowerPoint - Changing the look 

Font and colour of text
1. Select the text you wish to change.

2. On Format on the menu bar  click Font to change the font, font
size, font style and colour. It will change just the text selected.

Bullets

To change the bullets select the required text

Click on the Format menu

Click on  Bullets and Numbering.

Click on the Character button.
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Select a Wingding or Webding character in your font list (circled
below) to enhance the meaning of the content of the presentation.

Colours and Lines
To alter the colour and fills of objects:

Select the object you wish to change.
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Click on Format menu.

Click on Colors and Lines.

Click on the little arrows as indicated and alter as required.

Creating your own template

To change the colours and fonts on all the slides:

Click on  View

Click on Master

Click on Slide Master

Alterations made will change all slides in the presentation.

To insert a school badge (logo) or graphic on all slides, insert and
position it on the Master slide.
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PowerPoint - adding graphics 
Educators often build up a collection of subject specific graphics
saved in a special file. They may be found on a floppy disk in the A
drive, in a folder on the C drive or on a CD-ROM disk in the D drive.

To insert graphics from a file 
Click on Insert from the menu bar, 

Click on Picture and then

Click on From File.

Scroll up until you find the required drive, in this case the C drive.
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In the selected drive, explore until you find the required folder. 

Scroll up or down until you find the required file.

Click on Insert.



59

Operate ICT applications in an education context

ICT Integration for Educators
© Namibia Training Authority - 2006

The picture is inserted into the presentation.  The handles are ready
for resizing.

To insert clipart
Click on Insert on the menu bar,

Click on Picture and then

Click on Clipart.

To insert WordArt or AutoShapes
Click on Insert from the menu bar

Click on Picture

Click on WordArt or AutoShapes.

Handles
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Moving

To move an object such as a box or graphic, select it, hold the cursor
down and pull the object to the position required.

 

PowerPoint - Adding animations and videos 
This is a simplified tip sheet giving basic assistance in PowerPoint. 
PowerPoint Help has assistance in advanced detail.

Animation in PowerPoint means to add a special visual or sound
effect to text or an object. For example, you can have your text bullet
points fly in from the left, one word at a time, or hear the sound of
applause when a picture is uncovered. You can animate any number
of objects on a slide, and you can even animate elements of a chart.

Videos (movies) can be added to PowerPoint presentations.

An animated GIF is a file that contains a series of GIF images that
are displayed in rapid sequence to produce an animated effect.

To animate text and objects
Click on View, then

Click on Normal

and display the slide that has the text or objects you want to animate.

On the Slide Show menu bar

Click Custom Animation, and then

Click the Effects tab. 
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Under Check to animate slide objects, select the check box next
to the text or object you want to animate.

In the illustrated example the text will be animated, and will Fly in
From left.

Repeat for every object you want to animate.

To change the order of animation
Click the Order & Timing tab.  

Under Animation order select the object you want to change, and
then click one of the arrows to move the object up or down in the list.

To view the animation
Click Slide Show, then

Click on View Show

To insert a video (movie) to a slide 
Display the slide you want to add the video to.

Click on the Insert menu

Click on Movies and Sounds. 

Do one of the following
To insert a video from the Clip Gallery, click Movie from Gallery,
and then locate and insert the video you want. 

To insert a video from another location, click Movie from File, locate
the folder that contains the video, and then double-click the video
you want. 
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Position the video clip on the slide.

To view click Slide Show, then View Show.

To insert an animated GIF picture on a slide 
Display the slide you want to add the animated GIF picture to. 

Do one of the following: 

To insert an animated GIF picture from the Clip Gallery, click Insert
Clip Art on the Drawing toolbar and then click the Motion Clips
tab. 

To insert an animated GIF picture from a file, on the Insert menu,
point to Picture, and then click From File. To view the animated
GIF picture, click Slide Show, then View Show  
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PowerPoint - Adding sound 
To insert music or sound on a slide

Display the slide you want to add music or sound to. On the Insert
menu, point to Movies and Sounds.

Do one of the following: 

• To insert a sound from the Clip Gallery, click Sound from Gallery,
and then locate and insert the sound
you want.

• To insert a sound from another
location, click Sound from File,
locate the folder that contains the
sound, and then double-click the
sound you want.

• A sound icon appears on the slide.
Follow the instructions to make the
sound heard when you require it.  To
view-hear click Slide Show, then
View Show.
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To Add Sound to an Object on a slide
On the Slide Show menu bar

Click Custom Animation, and then

Click the Effects tab

Click on the down arrow to the right of [No Sound]

Sound, such as Applause, can be added to the animation.  Be aware
that such sounds can become an irritant to the viewer if not well
chosen, and in creating a presentation learners can spend too much
time focussing on sound effects and neglect to focus on the content
of the presentation.

PowerPoint - Viewing the presentation on paper 
Viewing your presentation on paper 

Options are available before you print 

Click in the File menu

Click on Print

Individual Slides can be printed as transparencies. Be careful not
to have a coloured background as on a transparency as it can detract
from the main focus. 

Handouts can be printed for the audience, usually 6 per slide,
suggested in Pure black and white, with Frame slides. 

Notes Pages are printed for the presenter with their own notes,
written for each slide in Normal View. 

Outline View can be printed just showing the text version of the
presentation, usually for the presenter.
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Save, Close presentation and Exit the programme

To Close Presentation

To Save Presentation

To Exit Programme
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Open Office Impress - Creating a
multiple slide presentation
Open a presentation

Opening the program from the start menu

Once Impress opens, there will now be a window called AutoPilot
Presentation. You will progress through 3 windows to begin your
presentation.

Create multiple slide presentation
The Open existing presentation option will allow you to navigate to
a presentation that is already created, while the From template
option allows you to choose from existing templates. There are two
types of templates:

• Introducing a New Product

• Recommendation of a Strategy

These templates choices contain seven different types of slide
designs that help you organize information. Once you select a style
type, you will be presented with two color schemes. The Auto Pilot
will also ask general questions, such as company name in order to
auto fill some fields in the AutoPilot Presentation window.

1. If you do not want
to use a template,
select Empty
presentation.

2. Click Next.

3. On the following
window, select Next.
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4. Click on Create.

Creating Slides

Inserting Text

Inserting text is very simple.  Just follow the directions – wherever it
says ‘Click to add______’, click and type in your text.

Selecting a Template
Now the “Modify Slide” window will appear.  There are 20 templates
to choose from.  Just click on the template you want to use.
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Adding slides
On your screen, there should be a small box (usually in the bottom
right corner) which is called the
‘Presentation box’.  It lists 4 options:

Insert Slide

Modify Slide Layout

Slide Design

Duplicate Slide

To add new slides to your presentation, click on Insert Slide.  The
Modify Slide window will appear again for you to choose which
template you want to use.

Formatting slides
Formatting the Background

1.  Go to the Format menu at the top of the screen and click Area.
Here you can apply colour or designs to the background of your
presentations.  This pop-up window will appear:

2.  Click on the different circles to see various options.  For instance,
these are the Colour option – use the scrollbar to see all available
colors.  Explore Bitmap as well for other Area options.

3.  To apply a colour or texture to your slides, you must click on part
of your slide, for instance the box for inserting title, then go to
Insert > Area.

Duplicating slides
Click on the ‘duplicate slide’ in the ‘presentation box’.

Slide show effects
You can add various animated effects to your slides.  These can be
applied to either transitioning between slides or to your text.
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Slide transition
Slide transitions are the way that one slide moves to another.

1. Go to the Slide Show menu at the top of Impress and select
Slide Transition.  This window will come up:

2.  Choose an effect from the dropdown menu.

3.  Click on effects (the name for each will be shown underneath
options)

4. You can preview by clicking on the Preview icon on the upper
left of the window

5. You can apply an effect by clicking on ‘check’ or ‘tick’ icon,  Assign
(next to Preview icon).

6. You can change the speed of the slide transition effect by
choosing between slow, medium and fast with bottom dropdown
menu.

Animation effects
Animation effects are for text, altering the way that the text appears
on slide.

1.  Go to the Slide Show menu and select Animation Effects.

The Slide Master
The Slide Master is a special slide that controls certain text
characteristics – such as font type, size and colour – called “master
text,” as well as background colour and certain special effects, such
as shadowing and bullet style.

 

Click here for dropdown menu
listing all effect categories.  Once you
select a category, various options will
appear in the large box below.

Assign

Update Preview

Click here to change the slide transition
speed: Slow, Medium or Fast
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When you want to make a global change to the look of your slides,
you do not have to change each slide individually.  Just make the
change once on the Slide Master, and Impress automatically updates
the existing slides and applies the changes to any new slides you
add.

Formatting the Slide Master
Go to the View menu at the top of Impress, select Master (towards
the bottom of the drop-down menu) and then click on Title.

Viewing slides in different modes:
There are several ways to view your presentation, listed on the right
side of the Impress window.

• Drawing view

• Outline view

• Notes view

• Handout view

• Start Slide Show (can also go to Slide Show menu at top and
select Slide Show)

Save And Close Your Presentation
Click File > Save As. In the “Save in “ pull-down menu box, click My
Documents (if it is not already selected). In the “Save as” type: pull-
down menu box, click OpenDocument Presentation (.odp) (if it is
not already selected).

In the File name: box, type My Slide Show

Click Save.

Click File > Close.

Click File > Exit.
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If your learners are using the presentation application, make sure
you work in time for learners to create the presentation and also to
practise, before presenting to the whole group or class.

Deliver an ICT presentation
There are many creative ways in which you can use an ICT
presentation in your lessons. Presentations tools are very powerful
tools, not only for educators, but also for learners to create projects
on a specific topic and do a presentation in class.

Many of the principles for giving a good ICT presentation in a lesson
are the same as for any good presentation without ICTs, but there
are some extra issues when using the technology at the same time
as presenting.

Integrate in to lesson
During the planning process of integrating the ICT presentation into
your lesson, you need to:

Create your unit plan
• Decide if the presentation tool will be used by you or the learners.

This will be determined by the lesson objectives and activities
you choose.

• If you are using the presentation application, create a story board
to guide your presentation.  You can do this by drawing rough
sketches on paper or using a word processing application.  You
can later enhance the presentation with graphics, animations or
photos etc. Your story board should consist of:

• An opening slide with your title and your name

• What subject and grade level (if appropriate) your unit will
target

• Your curriculum questions

• Your learning objectives.

Create an outline of the content

Collect resource material for your presentation, such as pictures,
graphs video clips, etc.

Apply presentation principles
An ICT presentation should only be shown on a large computer
screen to a small audience, or with a data projector and large screen
to a large audience.

How are some tips for presenting with an ICT presentation
application:
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Before delivering your presentation:

• first note down the aim of the presentation

• then list the contents of the talk

• create a presentation to enhance the meaning of that content.
Do not use the presentation application if you do not need to, or
if your talk could not be enhanced by using it.

• limit the presentation to approximately 12 slides and limit the
content on each slide (if there is too much to read on the slides,
the learners will not be listening to you)

• create speaker notes for yourself

• practise giving the talk using the speaker notes and
synchronising the talk with the mouse control

• know the content so that you can talk about the key words/
illustrations on the screen while looking at the audience

• check the size of the font (text), with regard to the size of the
venue

• prepare handouts for the audience, if required

• check that the sound, if used, works on the equipment to be
used

• check the lighting to be used in the venue, and how the screen
can be seen

During the presentation:

• Look at the audience and share the content of the presentation
with them.

• Avoid reading from the computer or projection screen.  The aim
is to have key points or graphics that you explain or expand on
while the learners look at both you and your slides. If you are not
looking at the learners they will lose interest very quickly.

• Stand to the side of the projector so you do not block the
projection screen.

Evaluate use of presentation
application
Reflecting on your ICT presentation can be rather difficult, because
you often feel so proud of your
work and would want learners
and colleagues to appreciate
the efforts that you put in it.
This might not be the case
and it is important to
objectively evaluate your
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Content: Does the content supports the targeted objectives?

Accuracy: Are your facts correct?  Make sure there are no spelling
or grammar mistakes and that you have accurate, complete, useful,
current and meaningful information.

Design layout and use of multimedia: Is the layout and slide order
logical? Do you have attractive multimedia elements, text, colour
and background of slides?

Lists and tables and links (if they are used).

Participation: Does the slides draw out active participation from
the learner?

Figure 6: What to focus on when modifying presentation material.

Focus on

Layout

Participation
Accuracy

Content

presentation after the lesson. It is important to ask the following
questions after your presentation:

• In what way was the multimedia presentation engaging, age
appropriate or beneficial to the learner’s learning?

• Did the use of the presentation enable students to work better,
faster, or more in-depth?

• Did the presentation enhance the learning of the topic?

• Did the presentation help learners achieve the learning
objectives?

Depending on the answers to those questions, you may need to
modify:

• the use of the presentation application

• the content or breadth of your presentation

• your delivery of the presentation.

What can I do to modify and implement the presentation again?

• Modify materials/delivery strategy

• Layout

In many cases there are some changes to be made and it is
important that you focus on the following:
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CHECK YOUR PROGRESS 2

CREATE AND USE ICT PRESENTATION
APPLICATIONS

1. What is an ICT presentation application?

______________________________________________________

______________________________________________________

______________________________________________________

2. Name two popular presentation software applications for educators in
Namibia

______________________________________________________

______________________________________________________

______________________________________________________

3. Tick the appropriate reasons for using ICT presentation applications with
learners:

� You can easily demonstrate processes

� You can easily give instructions

� It allows you to see 70% of graphics

� You can engage learners

� You can encourage learner attention by using graphics as well as
text

� It allows you to put in effects that learners can visualise

� It allows you to create situations to model

� It allows you to make models
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CHECK YOUR PROGRESS 2

5.  TRUE/FALSE statements

a. Open Office Impress and MS PowerPoint  are  a wordprocessing
applications �    True � False

b. The basic unit of a presentation application is a slide

�    True � False

c. You can open a presentation application from an icon on the desktop.

�    True � False

d. An outline is a summary of thoughts presented as headings and
subheadings �    True � False

e. Graphic objects such as pictures, graphs and tables are displayed
in the outline view.

�    True � False

f. Clip art provides a quick way to add professional –looking graphic
images to your presentation without creating the images yourself.

�    True � False

g. You cannot print out your slides from a presentation application

�    True � False

4. People tend to remember:

____ 

 
 
   ________ 

 
 
        ________ 

 
 
      _________ 

What you read 

What you hear 

What you see 

What you see and hear 
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6. Fill in the ways to do the following actions in the presentation application
that you have available to you:

Open Office Impress Microsoft PowerPoint

Open a presentation

Create multiple slides

View slides in different modes

Save, close and exit

7. List the procedures for delivering an ICT presentation:

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________

______________________________________________________

CHECK YOUR PROGRESS 2
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PRACTICAL  ACTIVITY 2

CREATE AND USE ICT PRESENTATION APPLICATIONS

1. Create an ICT presentation to use in one of your classes.  Experiment
with all the features explained in this section.

2. Deliver you presentation to colleagues before giving it to your class.

3. Design a lesson plan, showing how you would integrate your ICT
presentation.

4. Design and deliver a lesson in which you allow learners to create and
give presentations using the ICT presentation application that you have
available.
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Summary
Well done! You have completed Section 2 on Create and use ICT
presentation applications.

You should now be confident that you know what the term ICT
presentation means and be able to name at least two popular
applications used by educators in Namibia.  You should also be
able to explain the reasons for using ICT presentation applications
with your learners.  You should be able to create a multiple slide ICT
presentation and also be able to deliver the presentation to
colleagues and learners.

If you feel confident that you have achieved all the above, you can
move on to the next session where you will learn how to identify and
access educational software.

If you are unsure of any part, go back and revise or ask your instructor
or supervisor for assistance.


